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Rendering dengan Enscape 

 

Gambar 1 Hasil Rendering Interior dengan Menggunakan Enscape 

Perkembangan teknologi dalam bidang perangkat lunak dan perangkat keras telah menghasilkan 

kemajuan yang sangat signifikan untuk membantu pekerjaan manusia. Salah satu hasil dari 

perkembangan teknologi tersebut adalah dalam bidang rendering dan animasi. 

Enscape adalah sebuah software yang dapat kita gunakan untuk membantu proses rendering secara 

real-time dan untuk media Virtual Reality. Software ini nayak digunakan dalam bidang Arsitektur, 

Teknik, dan Konstruksi. Software ini dikembangkan oleh Enscape GmbH, yang didirikan pada tahun 

2013 dan berpusat di Karlsruhe, Jerman dengan kantor di New York, Amerika Serikat. Pada tahun 

2022, pengembang Enscape, Enscape GmbH, bergabung dengan Chaos, pengembang perangkat lunak 

rendering pesaing V-Ray. 

Persyaratan sistem Enscape 

Enscape tersedia untuk Windows 10 atau versi yang lebih baru dan Mac. Untuk nomor versi 

yang didukung saat ini, periksa halaman unduhan kami .  

Karena Enscape menggunakan ray tracing untuk rendering real-time, ia sangat bergantung 

pada kartu grafis (GPU) Anda untuk merender model Anda dengan cepat. Oleh karena itu, 

Anda memerlukan kartu grafis yang cukup kuat agar Enscape dapat berjalan. Anda 

memerlukan kartu AMD atau NVIDIA dengan setidaknya 4GB VRAM khusus (tidak dibagi). 

Sebaiknya selalu perbarui driver kartu grafis Anda untuk memastikan Enscape berjalan lancar. 

Anda dapat melakukannya melalui situs web NVIDIA atau AMD. Berikut ini 

tautannya: Pembaruan driver NVIDIA dan Pembaruan driver AMD . 

Dukungan dan informasi tambahan: 

 Persyaratan Sistem untuk Enscape 

https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/download/
https://blog-enscape3d-com.translate.goog/nvidia-rtx?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://www.nvidia.com/download/index.aspx
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://www.amd.com/en/support
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/system-requirements/?itm_source%3DEnscape-Blog%26itm_medium%3Dblog-post
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Cara mengunduh dan menginstal Enscape untuk 

SketchUp 

Untuk menginstal Enscape, Anda memerlukan Enscape Installer. Ini akan dikirimkan kepada 

Anda melalui email jika Anda telah mendaftar untuk uji coba gratis , telah mengajukan 

permohonan lisensi pendidikan , atau jika Anda telah membeli lisensi Enscape. 

Sebelum menjalankan penginstal, pertama-tama, tutup SketchUp, lalu mulai penginstal dan 

ikuti petunjuknya. 

Dukungan dan informasi tambahan: 

 Petunjuk Pemasangan Enscape 

 Langkah Pertama 

Membuka Enscape di SketchUp 

Enscape adalah plugin render SketchUp (juga tersedia untuk alat pemodelan populer lainnya, 

termasuk Revit) yang menyediakan akses langsung ke visualisasi waktu nyata dan realitas 

virtual bagi desainer. SketchUp akan secara otomatis mendeteksi bahwa Enscape tersedia 

setelah Anda menginstalnya. 
 

Enscape dapat ditemukan di bawah ' Extensions' pada bilah alat SketchUp. Anda dapat 

mengakses fitur-fitur Enscape di sini, atau Anda dapat membuat bilah alat Enscape terlihat 

dan, oleh karena itu, lebih mudah diakses. Untuk melakukannya, klik kanan pada bilah alat 

SketchUp dan pilih 'Enscape' atau buka View > Toolbars lalu pilih 'Enscape'. 

Untuk meluncurkan Enscape pertama kali, masuklah ke akun pengguna Anda. Buka 

Extensions > Enscape > About dan masuklah. Kemudian kembali ke Extensions > Enscape > 

Start Enscape.  

 

https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/trial-14/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/educational-license/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post
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Cara memulai Enscape dan merender di SketchUp 

Setelah Anda memasang Enscape dan membuka bilah alat, saatnya untuk mulai merender di 

SketchUp. Buka berkas proyek SketchUp Anda. Jika Anda tidak memiliki berkas proyek, Anda 

dapat mengunduh contoh proyek gratis dari situs web Enscape. 

Selanjutnya, klik tombol 'Mulai Enscape' pada bilah alat Enscape (atau buka Ekstensi > 

Enscape > Mulai Enscape).  

Enscape akan terbuka di jendela baru, dengan proyek Anda secara otomatis ditampilkan dan 

dipresentasikan dalam tampilan perspektif. Pada tahap ini, Anda dapat mulai menjelajahi 

model yang telah dirender. 

 

Sekarang kesenangan dimulai! Cobalah menukar material, mengubah geometri, atau 

menambahkan aset. Saat Anda menyesuaikan proyek di SketchUp, Anda dapat melihat 

perubahan langsung muncul di Enscape (jika Anda mengaktifkan Live Updates di Enscape). 

Anda juga dapat mengaktifkan ' Synchronized Views ' untuk menyinkronkan tampilan 

perspektif dari SketchUp ke jendela rendering Enscape. Sekarang, saat Anda menavigasi 

model SketchUp, Enscape akan mengikuti dan menyajikan tampilan yang sama. 

Kami akan membahas lebih rinci tentang cara merender gambar di artikel ini nanti. 

Dukungan dan informasi tambahan: 

 Memulai Enscape di SketchUp 

Menu Bantuan Enscape 

Enscape menyediakan Menu Bantuan untuk membantu Anda menggunakan plugin. Untuk 

mengaksesnya, tekan tombol H atau tanda tanya di kanan atas jendela Enscape Anda. 

https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/free-sample-projects/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/live_updates_and_view_synchronization/?itm_soure%3DEnscape-blog%26itm_medium%3Dblog-post
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/live_updates_and_view_synchronization/?itm_soure%3DEnscape-blog%26itm_medium%3Dblog-post
https://blog-enscape3d-com.translate.goog/enscape-for-sketchup-get-started?_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc#how-to-render-an-image-in-Enscape-and-SketchUp
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/start_enscape-win-sketchup/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post
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Bergantung pada fitur yang Anda gunakan, Anda akan melihat petunjuk dan kiat yang sesuai 

ditampilkan. 

Misalnya, saat berada di pengaturan 'View Management', Anda dapat menemukan petunjuk 

tentang cara menelusuri proyek Anda. W untuk maju, S untuk mundur, A dan D untuk 

bergerak ke kiri dan kanan. Bahkan informasi tentang cara mengubah waktu, menelusuri atau 

terbang di proyek Anda, dan mengubah sudut dan rotasi matahari. 
 

Kiat-kiat bermanfaat ini akan berubah saat Anda menjelajahi Enscape dan membuka berbagai 

fungsi. 

 

Menemukan jalan di Enscape 

Lihat Manajemen 

Merupakan praktik yang baik untuk menyiapkan tampilan di awal proyek Anda sehingga Anda 

memiliki titik referensi yang selalu dapat Anda kunjungi dan lacak kemajuan dokumen. 

Di jendela render Enscape, tekan F pada keyboard Anda setiap kali Anda ingin membuka opsi 

View Management. Di sini, Anda dapat melihat semua tampilan 3D proyek Anda. Jika Anda 

memiliki perspektif yang telah ditetapkan, Anda dapat langsung beralih ke sana. Jika Anda 

tidak memiliki pengaturan apa pun, klik tombol 'Buat Tampilan' di bagian bawah tab View 

Management, dan Enscape akan menyimpan posisi saat ini dan waktu siang hari di 

SketchUp. 
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Dengan mengklik tombol edit, Anda dapat menandai tampilan 3D sebagai favorit untuk 

memudahkan akses, atau Anda dapat menautkan prasetel pengaturan visual ke tampilan 

tersebut (sesuatu yang akan kita bahas di bagian Pengaturan Visual). 

Dengan mengeklik 'Buat Tampilan', Anda dapat membuat tampilan 3D baru di aplikasi desain 

Anda. Enscape akan menyimpan perspektif dan waktu serta pengaturan lain yang disalin dari 

tampilan yang saat ini dipilih. Anda dapat kembali ke tampilan yang dipilih kapan saja dengan 

menekan 0 pada papan angka Anda. Ini sangat berguna jika Anda tersesat dan menyediakan 

titik aman untuk selalu kembali. 

Untuk menutup Manajemen Tampilan, tekan Esc pada papan ketik Anda atau tombol 

beranda. 

Dukungan dan informasi tambahan: 

 Membuat, Memilih, & Memperbarui Tampilan 

 Kelola Tampilan 

Pengaturan Visual 

Anda dapat mengakses Pengaturan Visual dari jendela rendering Enscape: 

 

Di sinilah Anda dapat menyempurnakan tampilan visualisasi Enscape Anda, baik berupa 

gambar, video, atau pengalaman realitas virtual. Anda mungkin menemukan diri Anda di sini 

saat Anda siap mengekspor render dan ingin membuat tampilan tertentu atau jika Anda hanya 

ingin menguji berbagai pengaturan dan melihat bagaimana pengaruhnya terhadap visualisasi 

Anda. 
 

Di Pengaturan Visual, Anda dapat mengatur kamera, lingkungan, dan pengaturan ekspor. 

https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/create_select_view/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/administer_favorite_views/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post
https://blog-enscape3d-com.translate.goog/content-hub/webinars/deep-dive-enscape-visual-settings-americas?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
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Anda juga dapat menentukan detail tertentu, seperti gaya render (misalnya, mode putih), 

kecerahan buatan dan sekitar, serta kedalaman bidang. Anda dapat menyesuaikan 

pengaturan atmosfer, seperti kecerahan matahari dan langit malam, ketajaman bayangan, 

mengubah intensitas angin, dan banyak lagi. 

 

Di tab Output, Anda dapat memilih resolusi render, format file (seperti .png), apakah akan 

mengekspor lapisan render tambahan untuk pascaproduksi (seperti saluran alfa untuk gambar 

dengan latar belakang kosong), kualitas kompresi video, dan banyak lagi. 
 

Di sisi paling kiri jendela Pengaturan Visual, terdapat panah oranye kecil. Dengan 

mengekliknya, Anda akan membuka panel samping yang menyimpan preset Pengaturan 

Visual Anda. Klik 'Buat Preset' untuk menyiapkan preset baru. Sekarang Anda dapat memilih 

pengaturan yang sesuai dari tampilan sebelah kanan dan mulai membuat tampilan tertentu 

untuk adegan Anda. 
 

Anda bahkan dapat menghubungkannya dengan tampilan Anda di jendela Manajemen 

Tampilan. Semua pengaturan di antarmuka ini dapat dikontrol oleh preset. 
 
Dukungan dan informasi tambahan: 

 Pengaturan Preset 

Editor Material Enscape 

Enscape dilengkapi dengan Material Library dan Material Editor miliknya sendiri. Di sini Anda 

dapat menemukan berbagai material dan peta siap pakai. Anda juga dapat mengimpor 

material Anda sendiri dan menggantinya dengan mudah. 

Buka Enscape Material Editor dengan mengklik ikon bola kotak-kotak di bilah alat Enscape 

atau dengan masuk ke SketchUp > Ekstensi > Enscape Materials. 

https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/settings-presets/?itm_source%3DEnscape-Blog%26itm_medium%3Dblog-post
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Anda akan melihat jendela yang menunjukkan material yang dipilih di sebelah kanan dan 

daftar semua material dalam proyek Anda di sebelah kiri. Perhatikan bahwa Enscape Material 

Editor mengakses material yang sama seperti SketchUp, dan Enscape menambahkan 

beberapa informasi dan fungsi. 

 
Anda menyiapkan dan menerapkan material di SketchUp, tetapi Anda dapat mengeditnya di 

Editor Material Enscape. Di sini Anda dapat mengubah warna, tinggi (dengan peta tonjolan, 

normal, dan perpindahan), dan pantulan, yang mengontrol seberapa mengilap objek akan 

terlihat. 

Anda juga dapat mengimpor tekstur untuk membantu Anda menyiapkan material. Ada banyak 

situs yang menyediakan tekstur 3D gratis berkualitas tinggi , 

seperti Poliigon.com atau ambientcg.com . Lihat tutorial video ini pada menit ke-19:09 untuk 

mengetahui cara melakukannya. 

https://blog-enscape3d-com.translate.goog/free-rendering-textures?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://www.poliigon.com/
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://ambientcg.com/
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://www.youtube.com/watch?v%3DfsauVhb6n3Q
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Pembaruan dan penggantian material dari Enscape Material Library dapat dilakukan dari 

dalam Enscape Material Editor. Ini membantu Anda melihat, menguji, dan mengubah material 

dalam model Anda dengan cepat tanpa harus menggantinya satu per satu. 

Dukungan dan informasi tambahan: 

 Bahan di SketchUp 

 Editor Material SketchUp: Material Realistis yang Disempurnakan untuk SketchUp 

Pustaka Aset Enscape 

Pustaka Aset Enscape menyediakan lebih dari 3.000 model berkualitas tinggi yang 

dioptimalkan secara real-time bagi Anda untuk menyempurnakan pemandangan Anda, dan 

daftar itu terus bertambah seiring seniman 3D kami menambahkan lebih banyak lagi pada 

setiap rilis. 

 

Anda dapat mengaksesnya melalui SketchUp atau melalui bilah alat Enscape dengan 

mengeklik ikon pohon. Jika Anda membuka pustaka dari SketchUp – maka Anda hanya dapat 

menambahkan aset di dalam SketchUp. Untuk menambahkan aset langsung ke adegan yang 

dirender melalui Enscape, Anda perlu mengakses pustaka dari bilah alat Enscape. 

Mudah digunakan – cukup pilih model apa saja, klik dengan tombol kiri tetikus, dan tempatkan 

di SketchUp. Aset akan ditempatkan sebagai placeholder yang disederhanakan di SketchUp 

untuk menghemat kinerja, dan Enscape akan menampilkan model lengkap dengan detail 

tinggi. 

Aset offline 

Secara default, pustaka aset 3D akan mengunduh aset berulang-ulang. Namun, Anda dapat 

mengunduh versi offline pustaka dengan mencentang kotak 'Offline Enscape Assets' di sudut 

kanan bawah agar dapat dimuat lebih cepat saat memulai. 

https://blog-enscape3d-com.translate.goog/how-to-replace-materials-in-enscape?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/sketchup/
https://blog-enscape3d-com.translate.goog/sketchup-material-editor-enhanced-materials-sketchup?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
https://blog-enscape3d-com.translate.goog/best-practices-asset-library?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
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Anda dapat menandai aset sebagai favorit dengan mengeklik ikon bintang. Ini akan 

menyimpannya di folder favorit. 

Aset khusus 

Jika Anda memiliki model 3D kustom yang ingin digunakan sebagai aset Enscape, Anda 

dapat mengimpornya dalam format obj, fbx, atau gltf di tab Aset Kustom. Untuk informasi lebih 

lanjut tentang cara menggunakan aset kustom di Enscape, lihat artikel Basis 

Pengetahuan kami . 

Penempatan aset dalam Enscape 

Untuk membuka Asset Library di jendela render Enscape, klik ikon pohon pada bilah alat, atau 

tekan tombol l pada papan ketik Anda. Ini akan membuka antarmuka yang mengakses aset 

Enscape yang sama seperti Asset Library di aplikasi desain Anda, bahkan termasuk aset 

kustom apa pun yang mungkin telah Anda tambahkan. 

Di bagian atas, Anda akan menemukan bilah pencarian dan tombol kaca pembesar untuk 

mengonfirmasi pencarian Anda. Di sebelahnya, kami memiliki tanda tak terhingga yang dapat 

Anda klik untuk memfilter kategori umum dan aset favorit Anda serta ikon tag untuk 

mengakses berbagai tag dan mempersempit pencarian Anda. 

Setelah Anda memilih aset yang ingin Anda tempatkan di dalam pemandangan, klik aset 

tersebut menggunakan tombol kiri tetikus dan pilih permukaan tempat aset tersebut akan 

ditempatkan di visualisasi Enscape. Klik kiri lagi untuk mengonfirmasi penempatan. Anda akan 

melihat bahwa pada awalnya, Anda hanya akan melihat representasi placeholder berwarna 

abu-abu dari aset yang telah Anda tempatkan. Anda dapat terus menempatkan aset dan 

setelah selesai, klik 'Terapkan perubahan' atau 'Buang semua' jika Anda berubah pikiran. 

Menerapkan perubahan akan memuat model kualitas penuh dalam desain Enscape Anda, 

dan placeholder akan ditempatkan di proyek SketchUp Anda. 

Sekarang, saat menjelajahi desain Anda di Enscape, Anda dapat dengan cepat 

menambahkan aset di sana dan kemudian, daripada kembali ke SketchUp. Anda juga dapat 

memutar, mengubah skala, dan menempatkan beberapa aset dengan mudah. Untuk 

informasi lebih lanjut tentang ini, lihat tutorial video kami . 

https://blog-enscape3d-com.translate.goog/download-free-3d-visualization-resources?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/custom-asset-lib-2/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/custom-asset-lib-2/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://www.youtube.com/watch?v%3DfsauVhb6n3Q
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Dukungan dan informasi tambahan: 

 Menggunakan Pustaka Aset Enscape 

 Menggunakan Pustaka Aset Kustom 

Cara merender gambar di Enscape untuk SketchUp 

Merender gambar di SketchUp sangat cepat dan mudah dilakukan saat Anda menggunakan 

Enscape. 
 

Untuk merender gambar diam menggunakan Enscape, klik tombol Screenshot seperti yang 

ditunjukkan di bawah ini, atau gunakan tombol pintas, Shift + F11. Enscape akan menanyakan 

di mana Anda ingin menyimpan gambar dan akan segera merendernya. Selesai! Gambar 

Anda akan dirender hanya dalam beberapa detik. 

 

  

Ada juga beberapa pengaturan tambahan yang dapat Anda pilih, termasuk: 

 Mengubah resolusi : Buka tab Pengaturan Visual (jika Anda tidak yakin resolusi mana yang 

akan digunakan, gunakan resolusi default, Full HD). Jika Anda perlu mencetak dalam skala 

https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/asset-library-2/?itm_source%3DEnscape-blog%26itm_medium%3Dblog
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/custom-asset-lib-2/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post


MODUL 10 – Rendering dengan Enscape 

 

yang lebih besar, pilih Ultra HD atau nilai yang lebih tinggi (perlu diingat bahwa ini bergantung 

pada memori yang tersedia pada kartu grafis Anda). 

 Menyimpan ke lokasi default : Di tab Output, Anda dapat mengatur folder default jika Anda 

tidak ingin diminta memilih lokasi setiap saat. Anda juga dapat memberi tahu Enscape untuk 

memberi nama hasil render secara otomatis. 

 Mengekspor gambar tanpa latar belakang : Pilih png sebagai jenis berkas gambar, lalu 

aktifkan kotak centang Terapkan Saluran Alfa. Sekarang setiap bagian latar belakang yang 

tidak tersembunyi di balik geometri akan tampak transparan, sehingga Anda dapat dengan 

mudah menempatkan gambar pilihan Anda di belakang hasil render dalam perangkat lunak 

2D apa pun yang mendukung lapisan. 

 Pilihan pasca-pemrosesan lebih lanjut : Pilih untuk mengekspor Object-ID, Material-ID, dan 

Depth Channel di tab Output. 

Dukungan dan informasi tambahan: 

 7 Langkah Penting untuk Membuat Rendering yang Realistis 

 5 Praktik Terbaik untuk Membuat Rendering Interior yang Realistis 

 Panduan Pemula untuk Pencahayaan di SketchUp dan Enscape 

 Merender gambar di SketchUp dan Enscape 

Cara membuat panorama 

Untuk membuat panorama 360 derajat , cukup pindahkan ke lokasi yang diinginkan dan tekan 

tombol di bawah. Anda dapat memilih untuk membuat panorama mono atau stereo. 

 

Anda dapat memilih resolusi untuk panorama di tab Visual Settings Output. 
 

Panorama disimpan di antarmuka Upload Management yang dapat Anda temukan di 

SketchUp. Di sinilah Anda dapat mengunggah panorama ke cloud sehingga dapat diakses 

dari perangkat apa pun melalui browser. Anda juga dapat menyalin dan membagikan kode 

QR agar orang lain dapat melihat panorama Anda dengan memindai kode QR. 
 
Ada beberapa opsi tambahan setelah Anda masuk ke Enscape License Center , seperti 

membuat galeri atau tur (lihat tur panorama yang telah kami buat ini!).  

https://blog-enscape3d-com.translate.goog/7-essential-steps-to-creating-realistic-renderings?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
https://blog-enscape3d-com.translate.goog/interior-rendering-best-practices?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://blog.sketchup.com/article/a-beginner-s-guide-to-lighting-in-sketchup-and-enscape
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/saving-a-screenshot-win-sketchup/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post
https://blog-enscape3d-com.translate.goog/creating-panoramas-with-enscape-at-lakeflato?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://my.enscape3d.com/account%23!/login
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://my.enscape3d.com/account%23!/panoramaGallery/view/6d78a9a0-3744-4ec0-94d8-1e53b23a2bc2/9f4147c4-073f-4fdc-bf9d-d49f48b0c695


MODUL 10 – Rendering dengan Enscape 

 

 
Dukungan dan informasi tambahan: 

 Opsi Ekspor dan Format File Enscape 

 Panorama dan Karton 

Cara membuat video 

Untuk melihat cara merender video di Enscape dan SketchUp, lihat tutorial langkah demi 

langkah ini: 

Dukungan dan informasi tambahan: 

 Ceritakan Kisah Anda Melalui Video: Tips untuk Membuat Animasi di Enscape 

 Menggunakan Video di Enscape 

Cara mengekspor exe standalone atau web 

standalone 

Selain menggunakan Enscape untuk mengekspor gambar, panorama, dan video, Anda juga 

dapat mengekspor pengalaman mandiri interaktif yang independen dan membagikannya 

secara gratis tanpa pengguna akhir memerlukan lisensi untuk melihatnya. 

Untuk mengubah visualisasi Enscape Anda menjadi pengalaman yang dapat dibagikan, 

cukup gunakan tombol Exe di bawah ini. Ada dua jenis yang dapat dipilih - file mandiri Exe 

dan file mandiri web. Keduanya sepenuhnya kompatibel dengan VR, yang berarti Anda dapat 

dengan cepat menciptakan pengalaman realitas virtual . 

 

https://blog-enscape3d-com.translate.goog/export-options-in-enscape?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/panorama-cardboard/
https://blog-enscape3d-com.translate.goog/rendering-animations-in-enscape?hsLang=en&_x_tr_sl=en&_x_tr_tl=id&_x_tr_hl=id&_x_tr_pto=tc
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/video/?itm_source%3DEnscape-blog%26itm_source%3Dblog-post
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/features/architectural-virtual-reality/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://my.enscape3d.com/account#!/panoramaGallery/view/6d78a9a0-3744-4ec0-94d8-1e53b23a2bc2/9f4147c4-073f-4fdc-bf9d-d49f48b0c695


MODUL 10 – Rendering dengan Enscape 

 

Dengan mengklik tombol web mandiri, Enscape akan segera mulai mengunggah adegan 

Enscape ke cloud Anda, yang dapat dilihat di browser dari mana saja di dunia. Bagikan tautan 

dengan siapa saja atau taruh di situs web Anda. 
 

Jika Anda ingin berbagi visualisasi dengan seseorang menggunakan mesin yang memenuhi 

persyaratan sistem kami, Anda dapat mengekspor salinan Enscape yang identik dengan 

mengklik tombol mandiri Exe. Ini tidak akan lagi terhubung ke aplikasi desain Anda, jadi tidak 

ada pengeditan yang memungkinkan pada saat ini. 
 

Untuk mengekspor file mandiri Exe, yang diperlukan hanyalah mengklik tombol. Lihat tutorial 

video kami di bawah ini untuk melihat cara menyesuaikannya dengan logo dan merek Anda. 

Dukungan dan informasi tambahan: 

 Ekspor Web Mandiri di Enscape dan SketchUp 

 Ekspor Exe Standalone yang Dapat Dieksekusi di Enscape dan SketchUp 

https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/web-standalone-export/?itm_source%3DEnscape-blog%26itm_medium-blog-post
https://translate.google.com/website?sl=en&tl=id&hl=id&client=srp&u=https://enscape3d.com/community/blog/knowledgebase/standalone-export/?itm_source%3DEnscape-blog%26itm_medium%3Dblog-post

